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1 0BIntroduction 
The SX1230 is a single chip transmitter IC designed for operation in the licence free ISM bands between 290 and 
1020 MHz. The SX1230 is capable of operation either with or without an external companion microcontroller and 
features four internally de-bounced digital input pins to enable direct connection to switchgear for wireless remote 
control applications. Examples of both types of applications are shown below: 
 

 
Figure 1. SX1230 Stand Alone Operation with Companion E2PROM 

 
Figure 2. SX1230 Connections for Microcontroller Based Operation 

The SX1230 main features include:  
 +17 dBm to -18 dBm Programmable output power 
 1.8 to 3.7V Operating range with internal voltage regulation allowing constant RF performance 
 Narrow and wide-band operation 
 (G)FSK, (G)MSK and both filtered and unfiltered OOK operation. 
 Support of bit rates from 1.2 to 600 kbps. 
 Low battery detection 
 Integrated RC timer for timer / wake-up applications 
 Low phase noise -95 dBc/Hz at 50 kHz offset. 
 -40°C to +85°C Temperature Range 
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2 1BGetting Started 

2.1 10BKit Contents 
As illustrated in the figure below, the SX1230-12SKA Evaluation kit is composed of: 

 SX1230SKA board 
 SX1212SKA board 
 SMA Connectorised Antenna for 434 MHz 
 SX1230-12SKA CDROM including all necessary PC software and documentation 
 A CR2032 Cell for operation of the SX1230SKA in stand alone mode, in conjunction with the companion 

E2PROM. 

 
Figure 3: SX1230-12SKA Contents (CR2032 Cell not Shown) 

 

2.2 11BInstallation 
The software for the SX1212SKA and SX1230SKA must each be installed individually. The installation process for 
each is identical.  
 
SX1212SKA Advanced Mode Software Installation 

1- Put the CDROM in your computer and browse the contents of the CD. 
2- Open the “sx1212starterkitsetupweb.exe” manually. It can be found in the \Installers sub directory of the 

CD-ROM. 
3- Follow installation guidelines until the process is completed. Please note that .NET Framework 2.0 and the 

FTDI USB driver will be automatically installed if not detected on your computer. 
4- Connect the SX1212SKA board to the PC via the USB interface. 
5- Launch “SX1212SKA” from the Start menu. 
6- Click on “Connect” button in toolbar or in File menu. 
7- SX1212SKA is now installed and ready to be used. 

 
SX1230SKA Advanced Mode Software Installation 

8- Put the CDROM in your computer and browse the contents of the CD. 
9- Open the “sx1230starterkitsetupweb.exe” manually. It can be found in the \Installers sub directory of the 

CD-ROM. 
10- Follow installation guidelines until the process is completed. Please note that .NET Framework 2.0 and the 

FTDI USB driver will be automatically installed if not detected on your computer. 
11- Connect the SX1230SKA board to the PC via the USB interface. 
12- Launch “SX1230SKA” from the Start menu. 
13- Click on “Connect” button in toolbar or in File menu. 
14- SX1230SKA is now installed and ready to be used. 
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3 2BHardware Description 
SX1230SKA and SX1212SKA boards are summarised in this chapter. Please refer to the schematics and layout 
provided in the document for further information about each hardware implementation. 

3.1 12BSX1230SKA Overview 

 
Figure 4: SX1230SKA, 868 and 915 MHz Band, Board Picture 

 
The SX1230SKA is a USB based evaluation tool, which sees the SX1230 reference design (2) connected to a host 
PC via an FTDI USB to SPI bridge (1) and USB type ‘A’ connection (7). The SX1230SKA can also operate with in 
stand alone mode when battery powered. In this mode the initial configuration of the radio is downloaded from the 
first 77 bytes of the companion E2PROM (5). In response to a user push button input (6) a specific payload may be 
transmitted. The LED (3) corresponding to that button press illuminates to indicate transmission. 
 
For operation in the 434 MHz band the RF link between SX1230SKA and SX1212SKA is established through a PCB 
mounted helical antenna (4) to give a realistic impression of the range and other performances attainable in a 
miniaturised application.  
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3.2 13BSX1212SKA Overview 
The SX1212SKA features the SX1212 reference design (1) and is also interfaced via an FTDI bridge (6) to the USB 
type ‘A’ interface (2) of a host PC. Unlike the SX1230SKA, it has no provision for operation disconnected form the 
USB port. Indication of transmission and reception is indicated on a pair of LEDs (4). Connection to the separate 
antenna is made through an SMA connector (3) which can also be useful for laboratory based testing. 
 

 
Figure 5: SX1212SKA Board Picture 
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4 3BQuick Start Guide: MCU Mode 
With both SX1230SKA and SX1212SKA software installed, follow the sequence below to establish communication 
between the SX1230 as transmitter and the SX1212 as receiver. 

 

4.1 14BSX1212SKA Quick Start 
1. Plug the SX1212SKA into the USB port of the computer. 

 

2. Run the SX1212 User Interface software Start > All Programs > SX1212SKA > SX1212SKA 

 

3. The SX1212SKA should connect automatically to the User Interface 
Software. If not, then click on the USB connect short-cut button, located in 
the top left hand corner of the window. 

 

4. Once connected the SX1212SKA shows the default configuration of the SX1212 register settings 
upon power-up. 

 
Figure 6. SX1212 User Interface, Default Settings 

 
5. Once connected the SX1212SKA shows the default configuration of the SX1212 register settings 

upon power-up (as shown in XFigure 6X). 
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6. The settings for communication between SX1212SKA and SX1230 SKA are 
located on the installation CD-ROM provided with the kit. Use the File > Open 
from the menu bar, or the open short-cut button to load a configuration file. 

 

7. Load the “434_SX1212_pingpong.cfg” file from the “SX1212 Demo Files” folder on the CD-ROM.  

 

8. The display will then appear as shown in XFigure 7X. These are the link parameters which match 
those which will be programmed to the SX1230SKA. 

 
Figure 7. The New SX1212 Configuration: Ready to be Written 

 

9. By clicking on the write button in the ‘Registers config’ section, the 
new register values are written to the SX1212 registers. If 
successful, the red values in the hexadecimal register summary 
table will turn black. As a double check, the register read button 
may be pressed – the values presented on the user interface 
should remain unchanged. 

 

10. Click on the ‘Packet’ tab to access the packet testing portion of the program. Within this window a 
pre-defined packet structure is already configured. It remains simply to click the ‘Reception’ radio 
button and press the Start button. At this point the SX1212SKA enters packet receive mode and is 
now listening for valid packets. At this juncture the SX1230SKA transmitter must be configured. 
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Figure 8. The SX1212SKA User Interface whilst in Packet Receiver Mode 

 

4.2 15BSX1230SKA Quick Start 
 

1. Plug the SX1230SKA into the USB port of the computer. 

 

2. Run the SX1230 User Interface software Start > All Programs > SX1230SKA > SX1230SKA 

 

3. The SX1230SKA should connect automatically to the User Interface 
Software. If not, then click on the USB connect short-cut button, located in 
the top left hand corner of the window. 

 

4. Once connected the SX1230SKA shows the default configuration of the SX1230 register settings 
upon power-up (see XFigure 9 X). 
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Figure 9. SX1230 User Interface, Default Settings 

 

5. The settings for communication between SX1212SKA and SX1230SKA are 
located on the installation CD-ROM provided with the kit. Use the File > 
Open from the menu bar, or the open short-cut button to load a configuration 
file. 

 

6. Load the “434_SX1230_pingpong.cfg” file from the “SX1230 Demo Files” folder on the CD-ROM. 

 

7. The display will then appear as shown in XFigure 10 X. These are the link parameters which match 
those which will be programmed to the SX1212SKA. 
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Figure 10. The New SX1230 Configuration: Ready to be Written 

 

 

 

8. By clicking on the write button in the ‘Registers config’ section, the 
new register values are written to the SX1230 registers. If 
successful, the red values in the hexadecimal register summary table 
will turn black. As a double check, the register read button may be 
pressed – the values presented on the user interface should remain 
unchanged. 

 

 

 

9. Once successfully configured, the SX1230 must be placed in packet transmission mode. This is 
done by selecting the ‘MCU mode’ tab – note that a pre-configured frame format identical to that for 
the SX1212SKA is already entered into the display. It suffices simply to click on the ‘Start’ button to 
begin continuous transmission of this frame. For clarity a screenshot illustrating the display during 
transmission is shown in XFigure 11X. 
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Figure 11. SX1230 During MCU Mode Packet Transmission 

 

4.3 16BLink Test 
With both devices configured as described in the preceding two sections, reception of valid packets by the SX1212 
should be visible. Note that during link testing be sure that the USB kits are separated by several cm. Note also, that 
it is possible to install the SX1212SKA user interface on one machine and the SX1230SKA user interface on 
another allowing range test evaluation with full control over the link parameters. 

Where a pair of computers is not available, the SX1230SKA can be configured in stand alone mode. Please see the 
next section for a quick start guide on operation of the SX1230SKA in this mode. 
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5 4BQuick Start Guide: Stand Alone Mode 
 

5.1 17BSX1212SKA Configuration 
Initiation of the SX1212SKA for operation in Stand Alone Mode is identical to that described in Section X4.1 X. Please 
configure the SX1212SKA as described therein and refer to the following section for configuration of the SX1230. 
 

5.2 18BSX1230SKA Configuration 
There are a few simple steps to follow to configure the SX1230SKA for stand alone mode operation. XFigure 12 X 
shows both top and bottom views of the SX1230SKA hardware. The SX1230SKA companion EEPROM comes pre-
programmed with a band specific configuration file already loaded. 
 

1. Insert the CR2032 button cell into the cell holder (1), taking care to respect the polarity. Note that there is 
some quiescent current drain caused by the USB interface, so to maximise battery life ensure this is 
removed when not in use. 

 
2. Three of the four push buttons (labeled 0 to 3 on the PCB silkscreen) are connected to the general 
purpose digital inputs of the SX1230. The button labeled 3 is configured as a reset button. Push this button 
following connection of the cell. There should now be no LEDs illuminated on the SX1230SKA. 

 

 

 
Figure 12. Hardware for E2PROM (Stand Alone) Operation 

 
3. The SX1230SKA is not ready to be used in conjunction with the SX1212SKA in frame reception mode, as 
described in Section X4.1 X. 
 

2 

2 1 

3 
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5.3 19BLink Test 
Each push button has the same payload mapped to it. Push button 0 transmits this single, standard format frame, 
once. Push button 1 has a demonstration of packet repetition. Here the packet is programmed to be resent five 
times. Note that the SX1212SKA may not receive all five frames successfully. This is due to the time required to 
empty the FIFO, whereas SX1230 will transmit all five frames in quick succession. Finally, push button 2 gives a 
demonstration of periodic mode. Here the frame is configured to repeat several times a second whilst the push 
button is held down. 
 
To modify the E2PROM contents please see Section X6.7 X. Note also that the original quick start configuration is 
included on the CD. Please also refer to Section X6.7 X on how to load a non-volatile memory configuration file and 
program the E2PROM. 
 
Otherwise, guidance for performing link testing is the same as that already given in Section X4.3 X. 
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6 5BSX1230SKA Software Description 

6.1 20BOverview 
XFigure 13X shows the SX1230SKA graphical user interface (GUI). Each of the numbers surrounding the display 
corresponds to the Chapter within this section gives the description of that feature. 
 

 
 

 Figure 13: SX1230SKA GUI Overview and References to the User Guide Description of this Chapter. 
 

6.2 21BFile Menu 
File menu contains some general purpose functions. The first feature in the list provides 
the possibility of connecting or disconnecting to the USB kit. Care must be taken to ensure 
that the USB port is closed before unplugging the USB kit. This functionality may also be 
accessed through the short cut buttons (see Section X6.3 X). 
 
The possibility of opening configuration files and saving the present configuration is also 
provided. This is done through a standard Windows file dialog box. 
 
 

The Help menu contains two menu items. The first item provides a link 
to this user guide in PDF format. The second, ‘About SX1230 Starter 
kit…’, gives information in the revision of the software installed. 
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6.3 22BShortcut Buttons 
The shortcut buttons provide identical functionality to those listed under the file menu 

  

The configuration ‘file open’ shortcut button. This opens a windows file dialog box to allow access 
to previously saved SX1230 register configuration files. 

 

 The ‘save’ configuration file shortcut button immediately saves and overwrites the existing 
configuration file. 

 

The ‘connect / disconnect’ button allows the user to manage manually connection and 
disconnection of the kit. Note that any time the SX1230SKA is to be removed from the system; the 
kit must first be disconnected. 

 

The saved configuration files are designed to be a useful tool for embedded software development. The file can be 
opened in any text editor to display the programmed register name, address and hexadecimal value programmed to 
that address. 

 
Figure 14. Example Text Editor Output of the SX1230 Configuration File 
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6.4 23BGeneral Configuration Tabs 
For clarity and ease of use the general configuration settings have been split between two tabs. 

6.4.1 42BGeneral [1] 
The most commonly used configuration parameters are located on the General [1] tab. Each field is directly editable 
by the user and is refreshed every time a register read or write is performed.  
 

 
Figure 15. The General Configuration Tab Features the most Commonly Used Configuration Parameters 

 
Where the data entry field allows direct keyboard entry, the following background highlight conventions are used to 
aid the user in their choice of programmed value: 
 

An orange background highlight indicates that the precise 
value entered into the data entry field is not directly 
addressable by the SX1230. Instead the closest 
(rounded) value will be used. 

 
Conversely a red background highlight indicates where 
the maximum or minimum value for that register 
parameter has been exceeded.  
 



 
ADVANCED COMMUNICATIONS & SENSING    
 

Revision 1 March 2009 © 2009 Semtech Corp.  www.semtech.com 
 19  
 

User’s Guide
SX1230-12SKA

Each data entry field and user control of the General [1] tab is described below. 
 
RF Frequency 

The RF frequency field accepts a numerical text input 
from the keyboard. Values in any one of the three 
frequency bands from 290 to 1020 MHz are permitted. 
Please note that the entry units are Hz. 

 
Modulation Type 

The SX1230 is capable of both FSK and OOK modulation, 
they are selectable through the user interface by clicking 
with the mouse on the appropriate radio button.  

 
 
Modulation Shaping 

The Tx bit-stream may be pre-filtered before modulation. 
Varying strengths of filtering are accessible. The filter type 
also depends upon the type of modulation used. Filter 
coefficients are selectable from a drop-down menu. 

 
Bitrate 

 The bit rate of the transmitted signal (in bps) can be 
directly edited in this data entry field.  
 

 
 
Frequency Deviation 

Text entry field for the frequency deviation when using 
FSK modulation. 
 

 
 
Power Amplifier 

Selection of single (low power) or dual (high power) 
operation. Note that PAs 1 and 2 must be enabled for 
+17 dBm operation. 

 
 
Output Power 

The output power is selectable from a drop down list in 
the programmable 1 dB increments. 
 

 
PA Ramping 

The PA ramp rise time is selectable from the list of 
programmable values. 
 

 
Oscillator 

Although not directly accessible from the SX1230SKA, 
for completeness, the source of the clock output signal 
can be selected and its frequency altered in accordance 
with the range of programmable divider values. For 
more information please consult the SX1230 datasheet. 
 
 



 
ADVANCED COMMUNICATIONS & SENSING    
 

Revision 1 March 2009 © 2009 Semtech Corp.  www.semtech.com 
 20  
 

User’s Guide
SX1230-12SKA

Push Button Debouncer 
The four general purpose digital inputs – here connected 
to the four push buttons – has a variable debounce 
timer. Several common values are accessible from a 
drop down menu. 

 
 
PLL Lock Detection Parameters 

Three LED type indicators display the status of the 
SX1230 following the last register read cycle of the 
SX1230. Various options exist for changing the PLL 
divider ratio and triggering PLL calibration. Please 
consult the SX1230 datasheet for a more detailed 
description. 
 
 
 
 
 

 
 
E2PROM Mode Parameters 

These two register settings are used to determine the 
size of each section in the E2PROM memory and the 
wake-up time if periodic mode is enabled respectively. 
Please see Section X6.7 X, in conjunction with the SX1230 
datasheet, for a description of how to use these 
E2PROM parameters. 

 
 
Low Battery Detection Parameters 

The battery end of life (EOL) indicator is set if the EOL is 
enabled (here controlled by a radio button input) and the 
supply voltage passes the corresponding threshold – 
EOL trim. 
 
 
 

 
Crystal Frequency 

Most of the programmable communication setting 
parameters are a function of the crystal frequency used. 
This field allows other crystal frequencies to be tried, 
however, the SX1230SKA comes fitted with a 32 MHz 
crystal. The value should hence not be changed. 
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6.4.2 43BGeneral [2] 

 
Figure 16. Second Page of the General Configuration Parameters 

The second page of general configuration settings (see XFigure 16X) contains the user inputs for enabling of the power 
amplifier over current protection (OCP) and setting the current limit from a drop down menu. The current limit must 
be increased to 100 mA or higher for operation of the SX1230 at the maximum output power of +17 dBm. 

 

6.5 24BRegister Hexadecimal Display 
XFigure 17X shows the register summary of the SX1230. In addition to manual user entry in the fields described in the 
previous section, direct hexadecimal entries may be made into the register display. Note that values yet to be written 
to the SX1230 registers appear in red. Note, also, that for full control flexibility, incorrect (red) values entered in the 
hexadecimal section will still be written in the event of a register ‘write’. So care must be exercised when editing the 
hexadecimal values. 
 

 
Figure 17. Register Hexadecimal Display 

 

Note that values changed in this portion of the display cause the values in the tabbed configuration section to be 
changed dynamically.  
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6.6 25BOverview Panel 
A summary of the values presently entered into the user interface software is shown in the overview display at the 
bottom of the screen. This covers all of the SX1230 register values, including those not displayed on the tab 
presently selected, and indicates the true value which will be written to the SX1230 configuration registers. 
 

 
Figure 18. The Configuration Overview Display 

 

6.7 26BE2PROM Mode Tab 
The E2PROM mode tab is used to configure the contents of the E2PROM for stand alone mode operation of the 
SX1230SKA. In this mode the SX1230 acts as SPI master and can download both configuration and payload 
information from an SPI E2PROM. The E2PROM memory map is shown below: 
 

 
Figure 19. E2PROM Memory Mapping 

 
The bottom 0x4C locations in the E2PROM are reserved general configuration information – configuration which is 
the same for every button press. The subsequent sections are then mapped to the remaining 15 possible 
combinations of the 4 digital inputs (for mapping details please see the SX1230 datasheet). These may contain 
either i) solely payload or ii) a combination of supplementary configuration information and payload. 
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Figure 20. The E2PROM Mode Tab ‘Normal View’ 

 
The E2PROM mode display is broken down into two types, selectable by the radio button control in the bottom right 
hand corner of the display. The default is ‘Normal view’ which shows the E2PROM contents in human readable 
format (see XFigure 20X). The left hand ‘General Configuration Section’ dictates which registers are to be written to the 
general configuration section – True indicating that the value will be written, False that it will not. The values written 
to the configuration section are taken from the General setting tabs of Sections X6.4.1 Xand X6.4.2 X. The general 
configuration settings may be read or written independently of the rest of the E2PROM contents by clicking the Read 
or Write button within the section. 
 
The rightmost frame contains the contents of each of the input specific sections. The contents of a particular section 
are displayed individually. The section may be changed by entering the desired section in the ‘Section #:’ input. 
Several useful common parameters and the payload itself are listed within the ‘Buttons’ section. Each can be edited 
directly. The input specific section of the E2PROM memory can be written or read independently of the rest of the 
E2PROM contents by clicking on the write or read button within the Buttons Section. 
 
At the bottom of the display are the controls for global read or write of the E2PROM contents. These cause the 
whole E2PROM to be read or written, respectively.  
 
The radio button control in the bottom right hand corner allows selection between Normal and Raw views of the 
E2PROM contents. 
 
An alternative perspective of the E2PROM contents is available in ‘Raw view’, illustrated in XFigure 21X. Here we see 
the E2PROM contents in hexadecimal (centre column) and ASCII (right column) versus the E2PROM address in 
hexadecimal (left column) in tabular format. Note also the addition of several short-cut buttons. These allow the user 
to save or recall E2PROM (.NVM – non volatile memory) files to or from disc storage. Copy, cut and paste 
functionality is also provided. 
 
Once programmed the SX1230 may be disconnected from the USB port, unplugged and used in stand-alone mode. 
The SX1230SKA comes pre-programmed with an example E2PROM contents (see the quick start Section for more 
details). 
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Figure 21. E2PROM Raw View 

 

 
Figure 22. E2PROM Raw View Short-cut Buttons 
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6.8 27BMCU Mode Tab 

 
Figure 23. MCU Mode Tab Display 

 
The MCU mode tab allows the user to define a custom packet for transmission by the SX1230SKA. The packet 
configuration section (top) allows the user enable and set the length of a pulse train preamble (sent at the data rate). 
A custom syncronisation word of up to 4 bytes may also be added. Fixed or variable length packets may also be 
stipulated (see the SX1212 datasheet for more information), as may an optional 1 byte address. 
 
With these options entered the constructed packet is shown in the ‘Packet’ frame. The packet payload may also be 
edited in either ASCII or hexadecimal. Packet transmission starts when the ‘Start’ button is pressed. Either infinite 
transmission (repeat value = 0) or a finite number of packets may be transmitted by editing the repeat value. 
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6.9 28BThe Mode Control Box 

 
Figure 24. The Control Box 

The control box gives access to the operating modes of the SX1230. By selecting one of the radio buttons, the 
SX1230 is immediately transferred into that mode without the need to read or write to the registers. The control for 
reading and writing to the registers is also within the control frame. The Read button will read the contents of the 
SX1230 configuration registers and display them in the hexadecimal, overview and tabbed configuration areas. 
 
Similarly, a register write can be performed by clicking the write button. Here the contents of the hexadecimal 
display are written directly to the SX1230 configuration registers. 
 
Note that the E2PROM contents cannot be manipulated from this section instead see Section X6.7 X. 
 
 

6.10 29B MCU / E2PROM Mode Selection 
In the frame labeled ‘Mode’ either MCU or Stand Alone (E2PROM) 
operation can be selected. This allows the stand alone mode to be 
entered whilst connected to the USB port. Note that transition to 
and from E2PROM mode generates a hardware reset (transition 
cannot be made dynamically) and so the register contents of the 
SX1230 will be lost upon transition. 
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7 6BSX1212SKA Software Description 

7.1 30BOverview 
XFigure 25X shows the SX1212SKA graphical user interface. Each of the numbers surrounding the display 
corresponds to the Chapter within this section which corresponds to the description of that GUI feature. 
 

 
Figure 25. SX1212SKA GUI Overview and References to the User Guide Description of this Chapter 

 

7.2 31BFile Menu 
File menu contains some general purpose functions. Some of them can also be accessed 
on the toolbar by clicking directly on the icon. The first feature in the list provides the 
possibility of connecting or disconnecting to the USB kit. Care must be taken to ensure that 
the USB port is closed before removing the USB kit. This functionality may also be 
accessed through the short cut buttons (see Section X7.3 X). 
 
The possibility of opening configuration files and saving the present configuration is also 
provided. This is done through a standard Windows file dialog box. 
 

 
The Help menu contains two menu items. The first item provides a link 
to this user guide in PDF format. The second, About SX1212 Starter 
kit…, gives information in the revision of the software installed. 
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7.3 32BShortcut Buttons 
The shortcut buttons provide identical functionality to those listed under the file menu 

  

The configuration file open shortcut button. This opens a windows file dialog box to allow access to 
previously saved SX1212 register configuration files. 

 

 The save configuration file shortcut button immediately saves and overwrites the existing 
configuration file. 

 

The connect / disconnect button allows the user to manage manually connection and 
disconnection of the kit. Note that any time the SX1212SKA is to be removed from the system; the 
kit must first be disconnected. 

 

The saved configuration files are designed to be a useful tool for embedded software development. The file can be 
opened in any text editor to display the programmed register name, address and hexadecimal value programmed to 
that address. 

 
Figure 26. Example Text Editor Output of the SX1212 Configuration File 
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7.4 33BMcParam Tab 
Band Selection 

One of the six operating bands for the SX1212 may be selected 
here. The SX1212SKA hardware is band specific and so the 
corresponding band should be selected. Each band is further 
subdivided into a subband. This should also be selected. 

 

VCO Voltage Trim 

In some designs the VCO voltage requires trimming. The 
SX1212SKA reference requires the default offset of 180mV. 

 

Modulation Selection 

The SX1212 is capable of FSK and OOK modulation, for a full 
description please consult the datasheet. 

  

OOK Receiver Detection Type 

Several modes of OOK detection are possible, please see the 
SX1212 datasheet for mode information on configuring the OOK 
receiver. 

 

Data Mode 

Three data modes are available for the SX1212, typically packet 
mode is selected automatically, requiring no user selection, upon 
launching the Packet Test (see Section X7.12X). 

 

Gain of the IF Stage 

The gain of the intermediate frequency amplifier chain can be 
adjusted manually. 

 

Frequency Deviation 

Text entry field for the frequency deviation when using FSK 
modulation. 
 

 

Bit Rate 

The bit rate of the transmitted signal (in bps) can be directly edited 
in this data entry field. 
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Floor Threshold for OOK Detection 

Margin to the OOK demodulation threshold – see SX1212 
datasheet for more details. 

 

PA Ramping 

The PA ramp rise time is selectable from the list of programmable 
values. 

 

Frequency of Operation 

The frequency of operation of the SX1212 is a set by three 
frequency divider ratios. (See the illustration below). Based upon 
the frequency of the crystal oscillator and the values of these 
divider ratios the local oscillator frequency may be determined. 

 

To simplify this process, the SX1212SKA user interface sees this 
process completely automated. By entering the desired operating 
frequency in the text field at the top of the display, the resultant R, 
P and S divider ratios are calculated (see the SX1212 datasheet for 
information on their calculation). 

 

 

 

 

 
Figure 27. SX1212 Local Oscillator Generation 
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7.5 34BOverview Panel 
A summary of the values presently entered into the user interface software is shown in the overview display at the 
bottom of the screen. This is sub-divided into three sections pertaining to: general configuration, transmitter settings 
and receiver parameters.  
 

 
Figure 28. The Overview Panel 

 
 

7.6 35BRegister Hexadecimal Display 
XFigure 29X shows the register summary of the SX1212. In addition to manual user entry in the fields described in the 
previous section, direct hexadecimal entries may be made into the register display. Note that values yet to be written 
to the SX1212 registers appear in red. Note, also, that for full control flexibility, incorrect (red) values entered in the 
hexadecimal section will still be written in the event of a register ‘write’. So care must be exercised when editing the 
hexadecimal values. 
 

 
Figure 29. The Hexadecimal Register Display Summary 
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7.7 36BThe Mode Control Box 
The mode control box is sub-divided into three sections. The first ‘Operating mode’ allows the user to change the 
operating mode of the SX1212 by clicking on the radio button corresponding to the desired mode. Note that the 
transition between modes is instantaneous. The centre section, ‘Registers config’ allows the register settings 
entered elsewhere in the user interface to be written to the configuration registers of the SX1212 by clicking the 
write button. The read operation will read the configuration registers and refresh the user interface display with the 
values read from the SX1212. 
 

 
Figure 30. The Mode Control Box also Incorporates  RSSI 

 
The third, rightmost, section of the mode control box allows an instantaneous RSSI (received signal strength 
indicator) measurement. Please note that this feature is only accessible when the SX1212 is in the receiver 
operating mode. 
 

7.8 37BThe IrqParam Tab 

 
Figure 31. The Interrupt Mapping Display 

For total register coverage by the user interface, the interrupt mapping for the SX1212 can be controlled through the 
configuration of the IrqParam display. Note, however, that the hardware interrupt feature is not used directly by the 
GUI. For further information please see the corresponding register descriptions in the SX1212 datasheet and the 
PCB layout and schematics of Section X9 X. 
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7.9 38BThe RxParam Tab 
The receiver parameter field provides full access to all of the software configurable settings of the SX1212. For 
reference, a simplified block schematic of the SX1212 receiver is shown in figure XFigure 32X. The settings 
configurable in the receiver parameter tab correspond to the programmable baseband receiver functions. 
 

 
Figure 32. SX1212 Receiver Block Diagram, the Colours Correspond to the Frequency of Operation. 

 
 

 
Figure 33. Receiver Parameter Display 

 
For a complete description of the functionality of the receiver section please consult the SX1212 datasheet. 
However, the principle fields of interest for general use are: 
 
Rx Filters: 
The first three text entry fields of the receiver parameters correspond to the baseband filtering section. Note that the 
Butterworth filter is the narrowest of the three filters and determines the receiver channel bandwidth.  
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Bit Synchroniser: 
This block performs timing recovery and synchronises the decision on whether a given bit is logical high or low 
based upon the received bit stream. This block yields a substantial improvement in receiver sensitivity performance 
and it is hence recommended that it be left enabled. 
 
Sync Word: 
The synchronisation word is applicable to operation in buffered and packet modes. For packet mode operation the 
sync word is set using the packet editor – this may be found in the ‘Packet’ Tab (Section X7.12X). Link testing by the 
SX1212SKA is done in packet mode only – sync word provision is made here for completeness. 
 
OOK Settings: 
OOK demodulation is based upon measurements from the RSSI block and there are a rich variety of settings for 
how the OOK signal is detected and processed. These techniques and the corresponding settings are given a 
detailed treatment in the SX1212 datasheet. 
 
 

7.10 39B The TxParam Tab 
The transmitter configuration of the SX1212 is shown in XFigure 34X. This shows that the modulating signal is 
generated by direct digital synthesis (DDS), unconverted through the superheterodyne mixer stages and then 
amplified by a power amplifier chain. 
 

 
Figure 34. SX1212 Simplified Transmitter Block Schematic Diagram 

 
 

 
Figure 35. The Transmitter Parameter Tab Display 
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The three parameters which are configurable for transmit operation of the SX1212 are: 
 
Output Power: 
The output power of the SX1212 can be programmed in 3 dB steps. Valid programmable powers are selected from 
a drop-down list of valid values. 
 
Interpolation Filter Setting: 
The DDS output requires filtering to remove the spurii common in the generation of signals through this technique; 
this is performed by the interpolation filters. The cut-off frequency of the interpolation filters can be selected from the 
drop down menu of valid values. The technique for calculating the cut-off frequency may be found in the SX1212 
datasheet. 
 
Zero IF Architecture Enable: 
Configures the SX1212 for direct conversion transmitter operation. For a full description and the ramifications for the 
R, P and S divider settings please consult the SX1212 datasheet. 
 

7.11 40BThe OscParam Tab 
 

 
Figure 36. The Oscillator Parameter Display 

 
The oscillator parameter display gives access to the clock output functionality. This can be enabled or disabled and 
the frequency changed by entering a value in the ‘CLK out frequency’ text field. Note also that there is provision to 
change the frequency of the crystal. Changing of the crystal frequency has a knock on effect on all parameters that 
are a function of the reference frequency, for example bit rate, filter settings, RF output frequency. The SX1212SKA 
is fitted with the 12.8 MHz crystal recommended in the SX1212 reference design. For this reason the crystal value 
should, typically, be left unchanged. 
 

7.12 41B The Packet Test Tab 
The ‘Packet’ tab is the principle interface for conducting transmission or reception testing. The display, as shown in 
XFigure 35X is divided into three horizontal portions. The top portion of the display is given to the packet editor. Here 
the configuration of the packet, either to be transmitted or received by the SX1212SKA is constructed. 
 
The packet layout contains all of the features described in the SX1212 datasheet. This includes: 
 
Preamble 
This input allows the user enable and set the length of a pulse train preamble (sent at the data rate). 
 
Sync word size 
A custom syncronisation word of up to 4 bytes may also be added. 
 
Sync tol 
The number of errors which may be accommodated in the sync word (bits), before the packet is rejected. 
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Format / Length / Address 
Fixed or variable length packets may also be stipulated (see the SX1212 datasheet for more information), as may 
an optional 1 byte address. 
 
Digital Coding 
Optional channel coding including CRC, data whitening and Manchester coding are also available. 
 
With these options entered the constructed packet is shown in the ‘Packet’ frame. Where the SX1212SKA is to be 
used in transmit mode, the packet payload may also be edited in either ASCII or hexadecimal. Packet transmission 
is enabled by selecting the ‘Transmission’ radio button. This starts when the ‘Start’ button is pressed. Either infinite 
transmission (repeat value = 0) or a finite number of packets may be transmitted by editing the repeat value. 
 
 

 
Figure 37. The Packet Receiver / Transmitter Test Display 

 
For receive mode, the normal mode of operation in conjunction with the SX1230SKA, the reception the ‘Reception’ 
radio button is selected and the start button pressed. From this moment the SX1212 is placed in receive mode and 
listens continuously for a packet corresponding to the format entered in the packet editor. Upon successful 
reception, the payload received is shown in the ‘Message Box’ and the number of received packets is incremented. 
For indication of the signal strength received by the SX1212SKA, the RSSI display (see Section X7.7X) is activated 
and continuously refreshed. 
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8 7BSchematics and 4-Layer PCB Layout: SX1230SKA 
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9 8BSchematics and 2-Layer PCB Layout: SX1211/12SKA 
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